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1	 INTRODUCTION 

The MTL83xC is a temperature (and mV) measuring system.  It consists of 
an MTL838C and one or two MTL831C modules.  See the datasheet EPS 
MTL830 range and installation manuals INM MTL831C and INM MTL838C 
for these modules for further details.  The main interface is on the 
MTL838C which concentrates the data from the MTL831Cs is Modbus® 
RTU (RS485).  However, the MTL83xC system can also be configured to 
communicate with the Honeywell IOLP and emulate the LLMUX.  

This document covers the operation of the PC software that is used to 
configure and monitor the system.  The focus is on the LLMUX Emulation 
mode and connection to a Honeywell IOLP.  For Modbus installations 
please see document INM MTL838C-MBF.

1.1	 PC Requirements:

The MTL83xC PC software will run on a  Windows® 10 computer.

This is a small application that doesn’t require a lot of space, memory, or processor 
speed.

A USB cable is used to connect to the MTL838C (USB-C) – not part of the 
MTL838C – purchase separately.

Modbus is a trademark of Schneider Automation Inc., North Andover, MA.
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2	 QUICKSTART GUIDE

 
This quickstart guide is written for an MTL83xC system based on an MTL831C 
temperature input multiplexer transmitter with an MTL838C multiplexer receiver. 

Before the actual installation, it is recommended that new users initially set up a 
simple system on the bench to become familiar with the MTL83xC system.  The 
minimum hardware required for a test system is as follows: 

 

	 MTL831C  		  Multiplexer transmitter 

	 MTL838C 		  Multiplexer receiver 

	 MTL5553/5053  	 Isolator (for hazardous area installations only). 

In order to run a test the following equipment will be required: 

 
	 A PC loaded with MTL83xC Configuration software  
	 Power supply 20 - 35V @ 500mA, 

together with suitable cabling for the following requirements: 

 
	 Data highway connections (see INM831C / INM838C) 

	 Power supply connections 

	 USB cable

The user will also need the following documentation for wiring information: 

	 INM831C  - MTL831C installation manual

	 INM838C  - MTL838C installation manual

Connect at least one sensor to an MTL831C.
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3	  BACKGROUND TO THE MTL838C

3.1	 The analog-input multiplexer system 

The MTL838C is an analog multiplexer receiver that is used with the MTL831C 
hazardous area millivolt input multiplexer transmitter. The status of up to 32 analog 
inputs may be communicated from the hazardous area to the safe area via a data 
highway, comprised of a simple twisted pair over distances up to 2000m. 

Each data highway must be protected by an MTL5053 digital isolator when the 
inputs are located in a Zone 0,1 hazardous area.  The MTL831C is typically used 
with thermocouple and RTD inputs and is intrinsically safe.  It can be mounted in a 
Zone 0,1 hazardous area and will accept 16 inputs.  For systems that do not require 
Zone 0 or Zone 1 installation, the MTL5053 can be eliminated.

Up to two MTL831C transmitters can be combined on a single MTL838C receiver 
input - up to a total of 32 analog inputs - as shown in Figure 1. 

         Figure 1 - MTL838C/MTL831C System Diagram

 
The MTL838C (in LLMUX mode), connects to a Honeywell IOLP.  It supports 
two RS485 connections either or both of which may be used.  Each port maps to 
an MTL831C and makes 16 channels of temperature, mV, or RTD data available to 
the Honeywell system.   

3.2	 Configuring the MTL838C 

The MTL838C must first be configured using software on a PC and the USB 
connection.  This configures things such as the unit mode (in this case LLMUX) 
and the measurement type for each port (mV/THC or RTD).  After the initial 
configuration, the MTL838C is ready to communicate with the Honeywell system.  
At this point, the remaining configuration may be done in one of two ways:

 
•	 on-line via the RS485 link, direct from the Honeywell system 

•	 off-line using the PC software and USB connection 
 
Using the PC software is only required for initial configuration but also is a useful 
tool to validate unit operation and retrieve diagnostic information.
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3.3	 On-line Configuration

 
The MTL838C supports configuring and de-configuring measurement channels and 
setting the line frequency from the Honeywell system.  Configuration data is stored 
in non-volatile memory within the unit.  One thing that cannot be configured from 
the Honeywell system is the number of wires used for connected RTDs.  The default 
configuration is for 3-wire RTDs.

3.4	 Off-line Configuration

Off-line configuration requires the use of the PC software.  Once configured, the 
configuration parameters are stored in non-volatile memory within the unit. 

As stated earlier, the PC Software must be used to configure the MTL838C before the 
unit will communicate with the Honeywell system (change from Modbus to LLMUX 
mode).  In addition, whether the connected MTL831C is to measure mV/THC or RTD 
must also be configured using the PC Software.  These are the basic items that must 
initially be done, however, there are some other reasons to use the PC Software:

•	 If the user wishes to use 2-wire or 4-wire RTDs, the PC Software may be used to  
	 configure the MTL838C.  Once an RTD channel is configured for a number of  
	 wires, that channel will be set that way until the PC Software is again used to  
	 change it.  Also the number of wires used on an RTD may be set on a channel by  
	 channel basis.

•	 The MTL838C contains two dry contact alarm relays that may be configured using  
	 the PC Software.

•	 The system operation may be verified using the PC Software – data will be in  
	 normal engineering units (°C, mV, ohms).

•	 Diagnostic information is available.

•	 Thermocouple resistance measurements are available – used for burnout detection.

NOTE

While communicating with the PC Software, communication via the  
RS485 links will be disabled.

3.5	 Initialization mode  
The MTL838C has two distinct modes of operation normal and initialization.
 
It will always enter initialization mode during power-up.  It can also be triggered by
the detection of internal hardware or software faults. 
 
During initialization, the unit will ignore all commands from the Honeywell system.
 
The initialization period will take several seconds to complete all the necessary
operations and calculations.  Following successful initialization, the unit will 
automatically enter, or return to, normal operation mode. 

If a corrupted configuration database is detected during initialization the unit will 
revert to a set of default values.  If this happens (very unlikely) the unit would need to 
be reconfigured via the PC Software.
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3.6	 Transmitter addressing

Each MTL831C transmitter accepts up to 16 sensor inputs and there can be one 
or two MTL831C transmitters connected to a single MTL838C.  The address of 
the MTL831C as seen by the MTL838C is determined by whether a jumper wire 
is installed on the MTL831C (using the AS terminals).  A jumper wire not installed 
gives the MTL831C an address of ‘1’ and a jumper installed gives it an address of 
‘2’.  The following shows that the transmitter address and Link address are the same.  
Channel numbers will be 0-15 on each link.

MTL831C Address RS485 Link

1 1

2 2

Addressing of the MTL831C transmitters affects which sensor is given which 
address in the MTL838C.  For example, if only one MTL831C is connected to the 
MTL838C but its address jumper is installed, it will be at transmitter address ‘2’ and 
it will be making its data available on RS485 Link 2. 

It is also important that with two MTL831Cs connected to a single MTL838C, that 
one and only one of them has the jumper installed.  Otherwise they will both be at 
the same address and communication between the MTL831s and the MTL838C 
will fail.  Likewise, there can be no more than two MTL831Cs connected to a single 
MTL838C.
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4	 PC SOFTWARE INSTALLATION 

 
The MTL83xC Configuration Software is only available from the Eaton (MTL) 
website.  Direct your browser to the following website and then locate the 
MTL83xC product page.  There will be a link on that page to download and install 
the software:

www.mtl-inst.com
 
When you click on the link, your computer will likely warn about the file (setup.exe) 
as it is an executable.  Allow it to Run the file.

Anti-virus software on your computer may also complain about not knowing 
whether the file is safe or not.  Tell it to Allow the execution of the file.

Finally, Windows will want confirmation that you want to install the application.  The 
following is a sample screen shot of the warning.  Notice that Relcom, Inc. is the 
publisher of the software as they wrote it for Eaton (MTL).

Allow the installation to proceed.

The application will be downloaded, installed, and will start running.

 
The Installer does not require Administrator privileges and installs only for the 
current user.  If multiple users on the computer need to use the software, they 
will each need to install it.
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5	 SOFTWARE OPERATION

This section covers the operation of the MTL83xC Configurator software.  For detailed 
operation of the hardware, please see the relevant installation manuals.

The following is the screen that appears when the software opens:

                                        Figure 2  - The MTL838C Tab

This is a standard Windows application that incorporates a typical Menu system 
and Tabs to organize the information.  The three Tabs cover the three possible 
pieces of hardware in an installation (seen in the images at the bottom of the 
screen).  Data relevant to the associated piece of hardware is on that Tab.  For 
example, information specific to the MTL838C is on the MTL838C Tab.  

It should be noted, however, that the configuration data for the entire system 
is actually stored on the MTL838C.  This allows an MTL831C to be replaced 
without requiring re-configuration.  When an MTL831C powers up, the MTL838C 
recognizes it and sends it the correct configuration.

The Connection Status section at the bottom is below the changing tabs and 
provides visual information on the status of the components.  In the image above, 
the PC software is not communicating with the MTL838C.  This is indicated by 
the Transmitting and Receiving LEDs being OFF and the MTL838C word being 
grayed out.
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After connecting a USB cable to the MTL838C and providing it power, the 
Connection Status changes to:

		                Figure 3 - Connection status

This Connection Status indicates that the PC software is communicating over the 
USB cable with the MTL838C – both LEDs are ON and the MTL838C word is green.  
The MTL838C is not communicating with the MTL831Cs in the above image.

Once MTL831Cs are connected to the MTL838C, then their titles will turn 
green as well.

As explained in the Background section for the MTL831C, #1 means Address 1 (no 
address jumper on terminals 7 & 8) and #2 is Address 2 (a wire jumper between 
terminals 7 & 8).  There can be one or two MTL831Cs connected to a single 
MTL838C and if there are two, they MUST have different address settings.  The 
address determines which MTL831C belongs to which Tab in the software.  Mixing 
them up or changing the jumpers may result in an unexpected configuration.

5.1	 Configuration Overview

 
It’s worth taking a minute to understand to overall philosophy of the MTL83xC 
Configurator software.  

To allow offline configuration (not being connected to the MTL838C while entering 
the configuration data), we created two fields on the screen for every configuration 
point.  One of the fields is editable and the other is the displayed value from the 
unit the PC software is communicating with.  If it is not communicating with a 
unit, then that field is blank.  An example field is shown below.  The dropdown is 
the PC software setting and the gray box below it is the value read back from the 
connected MTL838C.  Not all tabs use the same color scheme but the principle is 
the same.

There is a way to load and store configuration settings to your computer (see the 
Menu Command section).  With this capability, configurations can be carried out 
ahead of time and stored until the units are installed and ready to program.  The 
configuration is then loaded from your computer and downloaded to the unit.

When a small change needs to be made to an already configured unit, you can first 
connect to the unit and Upload its configuration, make the necessary modifications, 
and then Download the updated configuration to the unit.
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5.2	 The MTL838C Tab
The items on this tab allow you to configure the MTL838C.  Some of these 
parameters affect the entire system – others only specific aspects of the MTL838C.  
We will cover them in detail below:

5.2.1	 Communication Protocol

Two communication protocols for the RS485 Links are supported by the MTL838C.  
This manual only covers the LLMux Emulation.  The protocol is selected by using 
the dropdown.  Make sure the LLMux protocol is selected and programmed into the 
unit.  This is NOT the default value for this field.

Once the LLMux communication protocol is selected, the behavior of the software 
changes and the MTL838C tab also changes – see the image below:

5.2.2	 Tag Name

 
This field is user defined.  When properly filled in it may be used to identify this 
particular MTL838C in the plant.  Up to 24 alphanumeric characters may be 
entered in this field.  The field is blank by default.  The Honeywell system does 
not populate or request this data.  It is strictly for the user to identify a specific 
MTL838C using the PC Software.
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5.2.3	 Transmitters Connected

 
This pair of checkboxes tell the MTL838C what is supposed to be connected to it.  
There are three possibilies.  #1, #2, or both #1 and #2.  You cannot unselect both 
checkboxes as it makes no sense to have a system with no MTL831C.  The default 
condition is that two MTL831Cs are connected to the MTL838C.

5.2.4	 LLMux Types

Each MTL831C can be configured to measure mV/TC or RTD.  These dropdowns 
configure the respective MTL831Cs (#1 on the left and #2 on the right).  This setting 
then affects the dropdowns on the MTL831C #1 and #2 tabs for configuring each 
channel.  The Honeywell system also gets this setting when requesting status or 
data from the MTL838C.  When configuring channels from the Honeywell system, 
validation is performed to make sure the input type is valid for the LLMux Type that is 
configured.

5.2.5	 Line Frequency

 
The line frequency where the MTL83xC system is installed should be correctly 
selected from this dropdown box.  It may be either 50 or 60 Hertz.  The default is 60 
Hertz.  This is to allow the system to improve the rejection of line frequency noise.  
This parameter can also be configured from the Honeywell system.
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5.2.6	 Alarm Relay 1

 
There are 10 alarm conditions that can be used to trigger the alarm relay.  If multiple 
conditions are selected, then they are logically OR’d together.  Check the checkbox 
of the condition(s) that you want to trigger the alarm.  The gray box to the left of the 
checkbox indicates the way the currently connected MTL838C is configured.

If the “Comm Errors” condition is selected, the “Comm Errors Per Hour Threshold” 
is enabled.  Once programmed, the MTL838C will turn the relay ON when the 
selected number of Comm Errors Per Hour is exceeded.

Use the “Delay” field to require that the alarm condition must exist for this 
number of seconds BEFORE the alarm will be triggered.  If “Comm Errors” or 
“Hardware Failure” is checked and one of these occurs in the unit, the alarm will trip 
immediately (the Delay is ignored for these error conditions).

The “Stick on” parameter forces the relay to stay ON this number of minutes AFTER 
the alarm condition has cleared.

The following table describes the different alarm conditions:

Comm Errors Comm Errors are caused by the MTL838C getting CRC errors 
in transmissions from the MTL831C(s) or the MTL831C(s) miss 
responding to a command 3 times in a row (this triggers a Comm 
re-initialization with that MTL831C).

Hardware Failure Two possible conditions will cause this condition.  First, every 
minute the 838C verifies that the CRC of the configuration data is 
good.  A difference causes the error to be set – it is never reset.  
Secondly, there are two board temperature sensors that are used 
for cold junction compensation (CJC) for thermocouples.  If they are 
different by more than 5°C, the error is set – otherwise it is reset.

TC Burn Out If a thermocouple (TC) has increased in resistance by 50 ohms, it 
is considered close to burning out and this error is set.  See the 
diagnostic tab to see what the TC resistances are.

TC Intermittent A thermocouple is intermittently opening (could be a bad connection 
or it is broken).

TC Open A thermocouple channel is open.

mV Open A channel configured as mV is open.

RTD Open A channel configured as RTD (2 wire, 3 wire, or 4 wire is open).

RTD Miswired A 3 wire or 4 wire RTD is not wired correctly.  Note that some ways 
of miswiring 3 and 4 wire RTDs cannot be detected (typically read 
near zero in this case).

High Alarm A channel reading exceeds the High Alarm threshold (see MTL831 
#1 or #2 tabs).

Low Alarm A channel reading is below the Low Alarm threshold (see MTL831 
#1 or #2 tabs).
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5.2.7	 Alarm Relay 2

See the explanation for Alarm Relay 1.  The possible settings for both alarm relays are 
the same.  However, you can set each relay differently to get different errors to trip 
the two relays.

5.2.8	 Action Buttons

At the bottom of the channel area, there are four (4) buttons.  Only one of them is 
active (blue) because there is no MTL838C currently communicating.  This is the 
Reset Configs button.  If pressed, it will reset all of the parameters in the current tab 
to their defaults – which are as shown in Figure 2 above.  Note that this changes the 
configuration back to Modbus which will have to be changed to LLMux for operation 
with a Honeywell IOLP.

When there is a connected MTL838C the Download and Upload buttons are active 
(blue).  Pressing the Download button would send the configuration on the screen to 
the MTL838C and pressing the Upload button would bring the configuration in the 
MTL838C into the editable fields.

The Sign Off button is not used in LLMux mode – it may be ignored.

5.3	 The MTL831C #1 Tab

This tab contains the configuration for the MTL831C at address #1 (the unit 
without the address jumper).  Below is what the tab looks like when not connected 
to the PC.

                           Figure 3 - Configuration for 831C at Address #1
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This tab is arranged in rows and columns.  Each row is a different channel – ranging 
from 1 through 16 plus a 17th row labeled CJ (Cold Junction).  Each numbered row 
corresponds to that numbered channel on the MTL831C unit.  The following explains 
the column items for channels.  In each row, the white rectangular boxes would 
contain the current setting in the unit that is being communicated with.  They are 
blank because no unit is currently connected.

5.3.1	 Input Type

This dropdown is used to select the type of sensor that is connected to the channel.  
The dropdown will have two different lists in it depending on the LLMux Type setting 
on the MTL838C tab.  The following are the different options available. 

LLMux Type = mV/TC LLMux Type = RTD

Not Configured Not Configured

mV 2W RTD Ω

TC, B, Temp, CJC 3W RTD Ω

TC, E, Temp, CJC 4W RTD Ω

TC, J, Temp, CJC

TC, K, Temp, CJC

TC, R, Temp, CJC

TC, S, Temp, CJC

TC, T, Temp, CJC

 
		 Definitions:

		 2W – 2 wire (RTD) 
		 3W – 3 wire (RTD) 
		 4W – 4 wire (RTD) 
		 TC – Thermocouple. 
		 CJC – Cold Junction Compensated

5.3.2	 Safety Drive

Not used (disabled) in LLMux Mode.

5.3.3	 High Alarm

The number in this field will determine when a High Alarm is triggered  
(reading is above the High Alarm setting).  This can be used for the MTL838C 
alarm relays.

5.3.4	 Low Alarm

A reading below the value in this box triggers a Low Alarm.  Like the High 
Alarm, this data is available for the MTL838C alarm relays.
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5.3.5	        Input Zero, Output Zero, Gain 

Not used (disabled) in LLMux Mode.

5.3.6	 Reading 

This field shows the current reading from a unit if one is connected and 
properly communicating.  The reading status will be shown below the 
box if the reading is not valid (Open, Miswired, etc.).  The units of the 
value shown are millivolts, ohms, or degrees centigrade depending on the 
Input Type setting.  Note that this is not what is sent to the Honeywell 
IOLP.  A 16 bit value plus sign which represents a number of microvolts or 
milliohms is sent to the IOLP.  The Honeywell system then converts the 
data to the proper engineering units.

5.3.7	 The CJ Channel 

The CJ row displays the average temperature of the MTL831C board (there 
are 2 temperature sensors on the board).

5.3.8	 Moving around the Channel List: 

A scroll bar is provided on the right side which allows you to scroll through 
all 16 channels plus the “CJ” row.  You can also use the mouse wheel to 
scroll the list of channels.

Channels may be “selected” by clicking anywhere within the rectangular 
area that defines the row.  A selected row is highlighted blue.  Several 
standard Windows features are implemented to facilitate working with the 
channels.  These things are:

	 Copy				    -	 Ctrl C 
	 Paste				    -	 Ctrl V 
	 Select All			   -	 Ctrl A 
	 Toggle Row selection		  -	 Ctrl Click 
	 Update Row Range selection	 -	 Shift Click

In addition, right clicking on a row will pop up a menu that allows you to 
select  Copy, Paste, or launch the Input Calculator (disabled in LLMUX 
mode as it is Modbus specific).  The Edit Menu may also be used to select 
some of these features.
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5.4	 Action Buttons 

At the bottom of the channel area, there are four (4) buttons.  Only 
one of them is active (blue) because there is no MTL838C currently 
communicating.  This is the Reset Configs button.  If pressed, it will reset 
all 16 channels in the current tab to their defaults – which are as shown in 
Figure 3 above (Input Type = Not Configured, Safety Drive = None, Gain = 
1, the remaining fields = 0).

The following figure 4 shows what the tab would look like when 
communicating with an MTL838C that has one MTL831C connected to it 
that has been configured with all channels as “TC, K, Temp, CJC”.  Notice 
that no channels are connected (the Open status and high invalid reading).  
The Calibration status of the MTL831C is shown below it and should 
always be “Good” as they are factory calibrated.  Channel 1 is the only 
selected channel as it is highlighted (blue).

Figure 4 - MTL838C with one MTL831C connected configured TC, K, Temp, CJC 

When there is a connected system the Download and Upload buttons are 
active (blue).  Pressing the Download button would configure all of the 
channels on the MTL831C as mV – figure 5 and pressing the Upload button 
would bring the configuration in the MTL838C (for the MTL831C #1) into 
the PC software.  See the results of pressing these buttons in figures 5 
and 6 respectively.

Notice that the Safety Drive, Input Zero, Output Zero, and Gain fields are 
all greyed out (disabled) as they don’t apply when in LLMux Mode.

The Sign Off button is not used in LLMux mode – please ignore it.
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                                                             Figure 5

                                                            Figure 6
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5.5	 The MTL831C #2 Tab

This tab functions exactly the same as the MTL831C #1 tab.  The only 
difference is that it contains the configuration data for the #2 MTL831C.    

The figure below shows what the MTL831C #2 tab looks like when connected 
to an MTL838C and MTL831C #1.  Notice that there is no Reading because 
there is no MTL831C #2 connected.  However, the live configuration data is 
populated in the white rectangles because it is stored in the MTL838C and 
downloaded to the MTL831C #2 when the MTL838C detects it.

Note also that the MTL831C #2 is set as LLMux Type = RTD, so all of the 
channels are configured as 3-wire RTD.  This is the default number of wires for 
RTD measurements.  However, using the Input Type dropdowns, 2 and 4 wire 
RTDs may be configured on a channel by channel basis.

    Figure 7 - MTL831C#2 tab while connected to an MTL838C and MTL831C #1
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6	 THE MENU

 
At the top of the MTL83xC Configurator window is a menu that contains the fol-
lowing items: File, Edit, Devices, and Help.  Click on the menu name to drop its 
menu down and then click on the menu item to execute that function.  The Menu 
items are explained below.  Notice that the menu also shows the shortcut keys to 
access the function without using the menu.

6.1	 File

The File menu allows you to Save and Load the current configuration as well as 
Exit the program.

Saving and loading the MTL83xC configuration is very useful.  It allows you to 
pre-configure systems and save that configuration to your computer.  When the 
systems are then installed the configuration can be loaded from the computer 
disk and downloaded to the units.  This also allows you to keep a backup of 
the configuration of a system in case an MTL838C needs to be replaced or for 
some reason gets inadvertently altered.  Note that all configuration data is stored 
in the MTL838C, so replacing MTL831Cs does not require downloading of the 
configuration.  It is a good idea to consider where the configurations will be stored 
on the computer and how they will be named so they may easily be identified with 
a particular system.

The following window appears when you select “Save Configuration” 
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The default file name is “Configs.txt”.  Change its name to something more 
meaningful and press the Save button.  We recommend keeping the “.txt” file type 
so the program can easily access the files.  Also, although these are text files 
which are easily viewed and manipulated by standard Windows software, we do 
not recommend altering them in this manner.  It is likely that text files may already 
exist on your computer.  For this reason it is recommended that a new folder be 
created to save MTL83xC configurations in.

When you select “Load Configuration”, the following window appears.

Using the window features, browse to the location of the configuration data you 
are looking for and select the appropriate file.  Press the Open button to load the 
configuration.  This populates the configuration data on all 3 tabs.  It may then be 
downloaded to the MTL838C.

6.2	 Edit

The Edit menu is shown above.  The functions of all of the items listed except the last 
one has been covered in the MTL831C #1 Tab section.  The last one, “Reset System 
Configurations”, will reset the entire system configuration to the default settings.  This 
includes the configuration on the MTL838C, MTL831C #1, and MTL831C #2 tabs.  
Selecting this option will present the following screen:
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This allows you to confirm your intention to clear all configuration data to the 
defaults.  Press OK to continue with the reset or Cancel to abort.

6.3	 Devices

The Devices menu contains functions specific to the MTL83xC devices.  The first 
three are commands to reset the respective pieces of hardware and the fourth 
item launches the window allowing firmware updates of the connected devices.

All three Reset functions send a command to the selected device that tells it to 
reset itself (firmware reset).  This will only work if the devices are functioning well 
enough to receive and execute the command.  

A Reset MTL838C command not only causes the MTL838C to reset (assuming it is 
successful), but it also may reset the connected MTL831Cs.  If the MTL831Cs are 
powered by the MTL838C (non-hazardous installation), then reseting the MTL838C 
will also reset the connected MTL831Cs.  However, if the MTL831Cs are powered 
by an isolator such as the MTL5053, then a reset to the MTL838C will not reset 
the MTL831Cs.

The other two reset commands are for the MTL831C #1 and MTL831C #2 
respectively.  Again, assuming the MTL838C is functioning properly the command 
will be routed to the appropriate MTL831C.  Then if that MTL831C is also functioning 
well enough, it will reset itself.

The reset commands may be used if you feel that a unit is not functioning correctly 
and it may save a trip into the field.

Selecting the Update Firmware option brings up the following window:
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CAUTION

Updating firmware will cause the units to reboot which disrupts data transmission 
from the units.

At the top of the window the current firmware versions are displayed for the units.  
If a unit is not connected, then the version information is blank (as is the case above 
with the MTL831C #2).  The latest firmware will be available on the Eaton (MTL) 
website www.mtl-inst.com.  If you suspect that the unit has become corrupted 
(functionally – not just configuration data), then it may make sense to reload the 
same version of firmware.  Otherwise it’s only recommended to update firmware 
when a newer version is available.

NOTE

Calibration and configuration data are not disturbed by a firmware update.

The recommended procedure is to download and save the newer firmware on 
your computer.  You will download a single compressed ZIP file that contains both 
firmware files.  Extract the files from the compressed file into a folder on your 
computer.  Files that end in “.838” are firmware files for the MTL838C and files that 
end in “.831” are firmware files for the MTL831C.  The file name will contain the 
product name followed by the firmware version.  We recommend that you don’t 
rename the files.

When you are ready to update the firmware for the MLT838C, click on the Browse 
button in the Update MTL838C Firmware box.  The following file selection window 
will appear:
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Select the firmware version you wish to update your unit to and click on Open.  
The gray box next to the Browse button will be populated with the filename (with 
its full path).  This will also cause the Update MTL838C button to become active 
(blue).  Press the Update MTL838C button to start the firmware update process.  
This will take a minute or so and a progress bar with status messages will update at 
the bottom of the window.  When complete, the version at the top of the window 
should update to the version just applied to the unit.  If any errors occur, they will 
be displayed at the bottom of the window.  If you get an error, try again.  If that is 
unsuccessful, contact Eaton (MTL) for assistance.

A similar process is used for the MTL831C firmware update.  There is a separate 
box labeled Update MTL831C Firmware that contains the same Browse and Update 
buttons.  Use the same procedure to select a file and update the MTL831Cs.  The 
following window is displayed after selecting the Browse button for updating 
MTL831C firmware:

As with the MTL838C, select the file you wish to use for the firmware update and 
click the Open button.  The gray box next to the Browse button will be populated 
with the filename (with its full path).  This will also cause the Update All MTL831Cs 
button to become active (blue).  Press the Update All MTL831Cs button to start the 
firmware update process.  This will take up to 6 minutes and a progress bar with 
status messages will update at the bottom of the window.  When complete, the 
version at the top of the window should update to the version just applied to the 
unit.  If any errors occur, they will be displayed at the bottom of the window.  If you 
get an error, try again.  If that is unsuccessful, contact Eaton (MTL) for assistance.

Notice that the update process for the MTL831C will update ALL MTL831Cs 
connected to the MTL838C.
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6.4	 Help

The last menu is the Help menu.  Selecting Show Help or pressing F1 opens the 
instruction manual for the PC software (this document). This will open the PDF 
document for the mode that the software is currently in (Modbus or LLMUX).  If you 
get the wrong document, change to the mode you wish the documentation for on the 
MTL838C tab and try again. 

6.5	 Help / About MTL83xC Configurator:

The About MTL83xC Configurator option brings up the following window:

This is where you can find the version of the PC software that you are currently 
running.  The latest version will be on the Eaton (MTL) website at www.mtl-inst.com. 
We recommend using the latest version.  Download and install from the website.

6.6	 Help / Show Diagnostics:

The last two options have to do with diagnostic information.  The first option “Show 
Diagnostics” causes a fourth (4th) tab to appear that contains diagnostic information.  
When the Diagnostic Data tab is displayed, then the menu option changes to “Hide 
Diagnostics”.  Clicking on this will remove the diagnostic tab.
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6.7	 The Diagnostic Data Tab:

The following is what the Diagnostic Data tab looks like when it is first opened:

Initially the request for diagnostic data from the MTL83xC system is OFF as indicated 
by the red Toggle Reading button and no diagnostic data (numbers) being listed.  To 
begin receiving diagnostic data, press the Toggle Reading button.  It will change to a 
green color and data from the units will be received.  Note that even when diagnostic 
data is not being requested, it is being collected by the units any time they are 
powered up (if they are rebooted the data is lost).  The following shows the screen 
when diagnostics are being requested and updated live: 
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Notice that there are several fields where non-zero information is a good thing.  These 
are: 

Total highway packets sent A running total of the number of packets of data 
sent to either MTL831C.

Good packets received Tracked on each unit and is useful when comparing 
to Bad or Fragment packets to see what percentage 
of errors there are.

Measurements per 10 seconds This is a count of the number of measurements 
received by the MTL838C from the given MTL831C.  
It should be 100 as the MTL838C requests 
measurements from both MTL831Cs every 100ms.

The MTL831C #1 TCBO and MTL831C #2 TCBO tables are also not considered 
errors.  They contain resistance measurements of any Thermocouple channels.  
TCBO stands for ThermoCouple Burn Out and is when a thermocouple has increased 
in resistance by 50 ohms or more.  The Saved value is the resistance measurement 
of the thermocouple when the MTL831C was power up or rebooted, a Thermocouple 
was connected to a channel configured as a thermocouple after previously being 
open, or a channel was configured as a Thermocouple when previously configured 
as mV or RTD.  This saved value is then compared to a periodic measurement of the 
thermocouple resistance (shown in the Current column).  If the resistance difference 
is greater than 50 ohms, then the Thermocouple status is set to “Burn-Out”.  This 
burnout status is also available via Modbus (not the resistance measurements).  In 
the example above, only one thermocouple is connected and it is on channel 2 of the 
MTL831C #1.  Its Saved and Current readings are the same at 21 ohms.

There are some errors shown in the example above.  This is because the MTL831C 
#1 was disconnected from the Data Highway and then re-connected.  It is typical 
in this case to see a few errors.  The Bad and Fragment packets received at the 
MTL838C are due to Data Highway transitions due to unplugging and plugging 
in the MTL831C #1.  Similar things can occur if the MTL831C is reset via the PC 
Software as described in the Devices section.  Retransmits occur when an MTL831C 
is disconnected from the Data Highway.  A few of the Low msmt (measurement) 
quaility occur on the MTL831C whenever it is powered up.  The following table 
provide details on the diagnostic items:
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MTL838C Diagnostics

Total highway packets sent A running total of the number of packets of data 
sent to either MTL831C.

Good packets received Number of good (no CRC error) packets received 
from the MTL831Cs.

Bad packets received The number of packets that had a CRC error.  
Caused by connecting or disconnecting MTL831Cs 
or by noise.

Fragmented packets received A count of the number of incomplete packets 
received.  This is usually noise or connect/
disconnect of an MTL831C.

MTL831C #1 Retransmits Number of times the MTL831C did not respond 
to a command (the MTL838C is the bus master) 
and the command had to be retransmitted.  After 
3 consecutive missed responses the MTL831C is 
‘dropped’ and must go through re-initialization if it 
starts communicating again.

MTL831C #2 Retransmits Same as above but for the MTL831C with the 
Address Jumper (#2).

MTL831C #x Diagnostics (x = 1 or 2)

Good packets received Number of good (no CRC error) packets received at 
the MTL831Cs.

Bad packets received The number of packets that had a CRC error.  
Caused by connecting or disconnecting MTL831Cs 
or by noise.

Fragmented packets received A count of the number of incomplete packets 
received.  This is usually noise or connect/
disconnect of an MTL831C.

High or low voltage events High or low voltage events detected by the main 
microprocessor.  Multiple events can be recorded 
for a single voltage event.

PSoC3A: Low/high voltage events High or low voltage events detected by the A 
measurement microprocessor.  Multiple events can 
be recorded for a single voltage event.

PSoC3A: Low msmt quality events The main microprocessor detected a low 
number of measurements per second from the A 
microprocessor.

PSoC3B: Low/high voltage events High or low voltage events detected by the B 
measurement microprocessor.  Multiple events can 
be recorded for a single voltage event.

PSoC3B: Low msmt quality events The main microprocessor detected a low 
number of measurements per second from the B 
microprocessor.
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Modbus Errors Link 1 (or 2)

Unknown function The Modbus Host send a function code not 
supported by the MTL838C

CRC Error A CRC error occurred on a Modbus packet.

Cannot send – buffer too full Data is put in a buffer while waiting for the UART 
to transmit to the Modbus Host.  More data was 
ready to go in the buffer but there was not room 
for it.  This should not normally happen.

# of Modbus messages received Number of Modbus messages received from the 
Modbus Host.

# of Modbus exceptions sent Number of Modbus exception messages sent to 
the Modbus Host by the MTL838C.

NOTE

The only Modbus Error that can occur when in LLMux Mode is the “Cannot send –  
buffer too full” error.

6.8	 Help / Generate Diagnostics Report:

Once some diagnostic data has been acquired, the Generate Diagnostics Report is 
enabled in the Help Menu.  Selecting this option generates a text file report that can 
be sent to Eaton (MTL) for assistance in troubleshooting an issue.  This would be 
something that Eaton (MTL) would request that you do after having contacted them 
regarding the issue.  The following dialog box appears when the Generate Diagnostics 
Report option is selected:

Locate a suitable place to save the file and change the name to something that will 
easily identify it.  The file would then be emailed to your contact at Eaton (MTL) to 
assist in solving the issue.
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